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Getting Started

Excel is a powerful spreadsheet program. To open up a new Microsoft Excel
2001 document, double-click on the application icon. The new Project Gallery
will open with Excel Worksheet highlighted. Click the OK button.

The Project Gallery is also accessible from other Office 2001 applications: Word and
PowerPoint. It is the first item listed under the File menu.

When a new workbook is opened, there are generally three sheets in the workbook. Excel
opens onto page 1 of the book. New sheets can be added as needed. Each worksheet
can contain 65,536 rows and 256 columns. Each workbook can include 255 worksheets.
WOW! It boggles the mind, doesn’t it? Of course, you probably won’t need all of these
rows and columns and sheets. Your computer would probably run out of memory before
you got half done filling in information.

A single worksheet is composed of cells. Each little box you see is a separate cell. Cells
are arranged together in vertical columns and horizontal rows. At the top of each
vertical column is an alphabetic column heading (A, B, C, etc.) and in front of each
horizontal row is a numeric row heading (1, 2, 3, etc.) Each cell has an address based
upon which column and row that cell is in: i.e., the active cell in our worksheet is cell
A1–it is the cell at the intersection of column A and row 1. The name of the active cell
can be seen in the Formula Bar, if it is turned on.

At the top of your Excel screen is the Menu bar, just like you find in most Macintosh
programs. Below that is the Standard toolbar. The Formatting toolbar is not on by
default in Excel 2001. It has been replaced by the much more robust Formatting Palette.
Also missing in Excel 2001 is the Formula bar (below) which used to be located under the
Formatting toolbar. I highly recommend that you turn on the Formula bar: Go to
View ➪ Formula Bar.
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As in most other Mac programs, there are scroll bars on the right side and along the
bottom of the spreadsheet. Above the right scroll bar and to the right of the bottom
scroll bar are two small, heavy, black lines. These are split boxes that allow you to split
your worksheet to make it easier to look at cells which are far apart.

Data Entry
Moving Around the Worksheet

In order to enter information into a worksheet, you must select the cell(s) you want to
work with. You can select a single cell by clicking in it. If you’d rather, you can select a
range of cells. Start by pointing to the cell at the upper left of the range, press the mouse
button, and drag down and to the right until you reach the last cell you want in this
range. The entire range of cells will be highlighted and the active cell (the one where what
you types goes into) will be the first cell at the upper left.

This is a continuous range of cells (A1–C6). As you
tab from cell to cell, you will be constrained to remain
only in this area. When you’ve reached the last cell
(C6), the next cell you will move to will be back up to
cell A1.

To move around from cell to cell, click on the Tab,
Return, Shift-Tab or Shift-Return. This is what
happens:

Tab ➪ right Shift-Tab ➪ left

Return ➪ down Shift-Return ➪ up

In Excel 2001, as you hit the Tab key you go across the row. When you then hit the
Return key, you go to the beginning of the next row down, even if you haven’t defined a
range. If you are familiar with an older version of Excel, you may remember that after
tabbing across a row of cells, hitting the tab key took you down to the cell directly below
where you were instead of the beginning of the row.

An entire row can be selected by clicking on the Row Number (1, 2, 3, etc.). In a like
manner, an entire column can be selected by clicking on the Column Header (A, B, C,
etc.). The entire worksheet can be selected by clicking in the little box to the left of
Column A, above Row 1.
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Saving a Workbook

You should get into the habit of
saving your work early and often.
Soon after creating your document,
save it by choosing Save from the
File menu. Maneuver to where you
want the document to be stored,
type in a title and click the Save
button.

The document will be saved as an
Excel 98 workbook if you still have
Office 98 on your computer. It will
be saved as Excel 2001 if you
don’t have Office 98 anymore. In
any case, the two formats are
compatible. If you want to use the
document in an older version of
Excel, or in a different program,

hold your cursor down on the arrow to the right of the Save File as Type: box. You can
select from a whole slew of choices (28 on my computer).

Everyone knows they are supposed to save periodically while they are working, so that
if the electricity goes off, or if the computer bombs, then all their hard work isn’t lost. We
all know that, but sometimes we get carried away and forget to do it. Well, Excel has a
convenient AutoSave feature that will automatically save your work for you every so
often. This feature is not turned on as a default setting; you’ll need to set it up yourself,
but it’s easy to do.

1. Choose Tools ➪ AutoSave.

2. Click in the Automatic Save box and
set whatever time interval you want.

3. I would turn off the Prompt Before
Saving feature by making sure there is
not a check in that box.

4. Click OK.

If AutoSave isn’t available under the Tools menu, do this first:

5. Choose Add-ins from the Tools menu.

6. Click on the AutoSave option.

7. Click OK.
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Entering Information

There are four types of data you can enter into a worksheet: text, numbers, dates, and
formulas.

v Entries containing alphabetic characters are considered
Text, even if all but one character is a number. If you want
a text entry that consists entirely of numbers, such as part
numbers, apply the Text format to the cells.
[Select cells/row/column ➪ Format ➪ Cells… ➪ Text.]  Text
entries automatically align along the left side of a cell.

v Number entries are often used for making calculations.
These entries can contain numbers and some symbols: +  -
$  (  ). If an entry contains a letter, it will be recognized as
text, as mentioned above. Numeric entries automatically
align along the right edge of a cell.

v Dates can be entered and stored in Excel worksheets, and then calculations
can be performed on the dates, such as figuring out how many days old you
are. Valid date formats include: 12/31/01, 1-Dec-01, and December 31, 2001.
Just because you type the date in a specific way doesn’t mean that’s how the
date will look on the spreadsheet. We’ll discuss this in more detail soon.

v Formulas are special entries that tell Excel how to make calculations based on
values in other cells. Formulas must begin with an equal (=) sign. Once the
formula is entered, Excel performs the calculation and places the results in the
cell.

To enter information into the worksheet, click in a cell and type. Information appears
both in the cell and in the formula bar if it’s turned on. (See above for instructions on
turning it on.)

You can edit cell contents by clicking on the cell and then moving up to the formula bar
to make changes, or by double-clicking in the cell, you can edit directly in the cell.
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Once you’ve entered the desired information into the cell, you need to “lock” the
information in by hitting one of three keys:

v Return key “locks” the information into that cell and moves you down one
row.

v Tab key “locks” the information into that cell and moves you over to the right
one column.

v Enter key “locks” the information into that cell but the current cell remains
active.

v If you’ve typed in something but you change your mind and don’t want to
enter it, click on the big red X in the Formula bar.

If what you’ve entered into the cell is too long for the cell, it looks like the data flows
over into the adjacent cell:

If there is information in the adjacent cell, it looks like the information is cut off in the
cell to the left:

What happens is that the information is still within the single cell, but you just can’t see
it all. The cell needs to be made large enough so the entire entry shows:

The easiest way to do this is to highlight the Column Headings (A and B), place your
cursor on the line between cells A and B, and double-click your mouse button. This
forces all the cells in the column to “Best-Fit,” or to be as long as necessary for the cell
with the most information to all show.
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Calculations
Introduction

One of the reasons that Excel has become so widely used is that it is a mathematical
wizard. It can add, subtract, multiply, divide, crunch numbers, calculate formulas and
more, quicker and more easily than the fastest math whiz. Then the numbers can be
changed and with a mere press of the button, everything can be recalculated in less time
than it’s taking me to type this sentence.

What is a Formula?

A formula is an equation that performs operations on worksheet data. Formulas can
perform mathematical operations, such as addition and multiplication, or they can
compare worksheet values or join text. Formulas can refer to other cells on the same
worksheet, cells on other sheets in the same workbook, or cells on sheets in other
workbooks.

Formulas calculate values in a specific order. A formula in Microsoft Excel always
begins with an equal sign (=). The equal sign tells Excel that the succeeding characters
constitute a formula. Following the equal sign are the elements to be calculated (the
operands), which are separated by calculation operators. Excel calculates the formula
from left to right, according to a specific order for each operator in the formula. You can
change the order of operations by using parentheses.

Here are some examples of Formulas:

=5 simple value

=A3 simple cell reference: equals contents of cell A3

=A1+B1+C1 calculated value equal to the sum of the contents of cells A1, B1 & C1

=sum(A1:C1) same formula as above (this is actually a function)
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What is a Function?

A function is a predefined formula that performs simple or complex calculations. For
example, you can use the SUM function to add the values in a range of cells.

=SUM(A1:C1) This function will add up all the values of cells A1, B1 and C1. It
includes all the necessary parts of a function:

v     = (the equal sign)

v   sum (the function name)

v (A1:C1) (the range of cells to be acted upon)

In prior versions of Excel, you could click on the AutoSum button (on the Standard
toolbar) to add up a column of figures. This button has gotten much more robust. In
addition to adding figures, it can now get the average of a set of numbers, count how
many numbers there are, and give the maximum or minimum of a set of numbers. Simply
place the cursor in the cell where the formula is to appear and click & drag on the Auto
Sum button. Excel will make its best guess as to what numbers you want to deal with
and will place a formula in the formula bar. (The guess is made by looking for a
continuous range of numbers above or to the left of the current cell.) If the guess is
incorrect, you can simply adjust the formula in the formula bar.

There are many, many Excel functions. They are quite handy and can save you lots of
time. If you are interested in performing complex mathematical equations, you might
want to obtain a book that can teach you more about using functions. Also, Microsoft’s
Help feature can tell you quite a lot about functions…just ask the Office Assistant.
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Editing Data

Once you have “locked in” data, you must select that cell before you can make any
changes. To delete the contents of only one cell, select that cell and hit the delete key, or
simply type in new contents. If you need to change some of the existing data but not all
of it, select the cell, place the cursor at the desired location in the Formula bar, and make
the adjustment. You can also edit directly in the cell by double-clicking when selecting
the cell.

Original Worksheet

You can clear information from several
cells at once. Select the cells and chose
EDIT ➪ CLEAR ➪ ALL. There is no longer
a keyboard command to clear cells.
Clearing information from cells leaves
those cells empty.

To totally remove cells, you delete them.
This will cause the remaining cells to shift
position to fill up the removed cells
positions. Select the cells you wish to
delete, choose EDIT ➪ DELETE, and
choose if the remaining cells are to shift up
or left. You can also delete by making a
selection and typing Control-Hyphen.

To insert an entire row or column, highlight
the row/column heading and select
INSERT ➪ ROWS or INSERT ➪
COLUMNS.
You can also insert by selecting a
row/column and typing Shift-Control-+.
If you want several rows inserted, highlight
as many rows as you want before choosing
INSERT ➪ ROW.
If you only want to insert a few cells in the
middle of a worksheet, highlight how many
cells you want (where you want them
added) and choose INSERT ➪ CELLS.
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Relative Cell Reference

A concept that I would like to introduce now is cell referencing. Remember that each cell
has a different address, or reference. The first cell on a worksheet is cell A1. When using
formulas it is very common to refer back to a certain cell by the cell reference.

In the table above, cell D2 contains the formula =SUM(B2:C2) in the Formula bar.
However, the sum of the calculation, 30, appears in the cell itself. The formula refers
back to cells B2 and C2.

When the command Auto-Fill is used to calculate the rest of the totals, the same formula
is applied to the cells. However, cell D3 refers back to cells B3 and C3. Similarly, cell D5
refers back to cells B5 and C5. That is because the formula uses relative cell referencing.

Cell references adjust when you copy formulas and saves you from having to always
retype formulas over and over. Excel assumes that formula references should be
adjusted unless told otherwise.

TIP

The command Auto-Fill allows you to copy information from one cell to the
adjacent cells. You access this feature by moving your cursor onto the lower
right corner of the cell, clicking down on the mouse and dragging. It works for
formulas and lists, such as Months or Days of the Week.
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Absolute Cell Reference

Sometimes you don’t want the cell references to be adjusted. Sometimes you want Excel
to refer back to a certain cell no matter what! What can you do?! Well, you can identify
a cell as an absolute reference. To do so, merely insert dollar signs in front of both the cell
address labels: e.g. $B$1.

In the sample below, Suzie works 40 hours per week no matter how much she gets paid.
She wants to know how much she’ll earn if she makes $15, $20, and $25 per hour. Since
she always works 40 hours, she wants the formula to refer to cell B1 no matter what.

Look at the Formula bar for cell D5. The answer in D5 is the result of multiplying cell D3
by cell B1. In the formula, the dollar signs: $B$1 tell Excel to refer back to cell B1.
Without the dollar signs, when the formula was copied over, the formula would have
refered to cell D1, which is empty, so our answer would have been $0.

Copying, Cutting and Pasting

To copy & paste or cut & paste cell contents, you merely select the cell(s) you want and
choose cut/copy. That puts the information onto the clipboard. The selected
information remains showing in the original cell until you paste it into a new location.

To paste the information, select the upper left cell of the new location and choose Edit-
Paste. If some/all of the destination cells contain information already, that information
will be lost when new data is pasted into the cells. You can get around this by choosing
Edit-Insert Paste, which will insert the information into new cells at that location,
moving existing cells either down or to the right.
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The relative vs. absolute cell reference concept is important to understand here in the
editing section because cutting and pasting does not equal copying and pasting.

v When you copy, cell references are relative.

v When you cut, cell references are absolute.

As you can see in this example, cells B1,
B2 and B3 have been added together and
the sum is in cell B5. Note the formula in
the formula bar.

In this figure, cell B5 has been copied into
cell C5. That copied the formula
=SUM(B1:B4), but since copying  results in
relative cell references, then the formula
now reads =SUM(C1:C4), and the result is
0.

In the final figure, the formula in cell B5 has
been CUT and pasted into cell A5. That
resulted in there being nothing in cell B5,
and the formula for cell A5 is
=SUM(B1:B4). Nothing about the formula
has changed.

One more thing to note: unlike in word processing, when you paste something from the
clipboard, a copy is no longer on the clipboard. In other words, when you are in word
processing, you can paste an item an infinite number of times off the clipboard. In Excel,
you can paste an item ONCE off the clipboard.
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Office Clipboard

The new Office Clipboard feature is available in Excel. You can paste a seemingly
unlimited number of items onto the office clipboard and they’ll stay there until you
remove them. You can then paste items from the clipboard back into Excel or one of the
other Office 2001 applications (Word, PowerPoint).

To use the office clipboard, it must be open: View ➪ Office Clipboard. Then simply
highlight what you want copied and choose Edit ➪ Copy (z-C). To paste an item from
the clipboard back into Excel, simply drag it into position, or place your cursor where
you want the item, and click on the paste icon at the bottom of the clipboard.

This feature neatly gets around the problem of only being able to use something on the
Mac clipboard once. As I said, once an item is on the clipboard, it stays there until it is
deleted. Beware, however, because when you click on the Delete icon, it doesn’t ask if
you’re sure–everything is just gone, forever!

insert delete

insert all delete all
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Practice 1
Monthly Home Budget Worksheet

1. Open a new worksheet and save it as Home Budget.

2. In Cell A1, type MONTHLY HOME BUDGET. Hit RETURN twice and
continue to type in the headings as shown below:

3. Place your cursor on the line between column headings A and B. It will turn
into a double-headed arrow. Double-click your mouse to make column A get
bigger.

4. Click in Cell C3 and type January. Hit the Enter key. The cell will remain
active. Move your cursor onto the lower right corner of the cell and your
cursor will change into a hollow square. Hold down the mouse and drag
across to cell H3. As you drag you should notice a small yellow box with
month names. When you get to cell H3 it should be June. Release the mouse.
All the months from January to June should appear in a cell.

5. When you first release the mouse, the months are still highlighted. Choose
Edit-Copy from the Edit menu. Click on cell C10 and Choose Edit-Paste.
This will copy the months into Row 10.

You may also notice “marching ants” around the first set of months. Don’t
worry about them. They will disappear as we move along. If they really
irritate you, hold down the Command key and type a period ( z-. ).
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6. Select cells C4-H7 and type in the following amounts:

7. Select cells C11-H12 and type the following amounts:

8. To calculate Total Expenses:
Click in cell C8 (where the total expenses for January goes.) Click on the
Auto-Sum button in the Toolbar and hit Enter. Excel adds up the amounts in
cells C4-C7 and puts the total in cell C8.

9. Click on the little box in the lower right corner of cell C8. Hold down the
mouse button and drag across to H8. The formula will be copied across to
calculate totals for all the columns.

10. To calculate Incomes: highlight cells C13 thru H13 (click and drag). Then
click on the Auto-Sum button. All the columns will be calculated at once.

11. To calculate the Net income we can’t just use the Auto-Sum button because
this is a subtraction (Income - Expenses), and also because the cells are not
adjacent. So do this:

a) Click in cell C15. Type an EQUAL sign. (Formulas always start with an
Equal sign.)

b) Click on cell C13 (income total).

c) Type a hyphen (for a subtract sign)

d) Click on cell C8 (expense total).

e) Hit the ENTER key.

f) Use the Auto-Fill feature to drag the formula across thru June.

12. SAVE YOUR WORK!
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CHANGING APPEARANCES

13. There are several items to be bolded. This can be done one-at-a-time, but there
is a better way. Hold down the Command key (z) and click on the following
items:

v Cell A-1

v Row 3

v Cell A-8

v Row 10

v Cell A-13

v Row 15

Once all the items are selected, simply click on the B on the Formatting Palette.

14. The numbers have to be formatted as currency (add $$$). The absolutely
easiest way to do that is to highlight the cells you want formatted as $$$ and
click on the $ on the Formatting Toolbar. But that puts the dollar sign out at
the left of the cell, so we’re going to do it a different way. Also, in Excel 2001,
the Formatting Toolbar is not automatic. It needs to be turned on.

Highlight (drag across the column headings) columns C thru H. Choose
Format-Cells… from the Format menu. Make sure you’re in the Number tab. In
the box on the left, choose Currency.

In the box on the right, choose your favorite way to indicate negative numbers (I
like choice #4). Then click OK and your numbers will all have little dollar signs.

15. For the MONTHLY NET INCOME, I would like the dollar signs to be at the left
of the cell, just to be different. Highlight cells C15-H15 and click on the dollar
sign $ in the Formatting Toolbar.
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16. Let’s now set text alignments.
To right-align the row headings, select cells A3-A15. Click on the right
alignment icon on the Formatting Palette.

To center-align the months, select January-June in Row 3. Click on the
center alignment icon on the Formatting Palette. Repeat for Row 10

17. To center the title (MONTHLY HOME BUDGET) over the entire table, click in
cell A1 and drag over to cell H1. DON’T drag from the bottom right corner, just
drag from the middle of the cell. This will highlight the A row across the table.

18. Choose Format ➪ Cells…. Click on the Alignment tab and in the Horizontal
area, choose Center Across Selection.

Missing Icons

The Center-Across-Selection icon that you may have used in a previous
version of Excel is not readily available in this version. You can add it to a
toolbar. If you remind me, I’ll show you how. Or you can just turn on the
Formatting Toolbar, which contains both the dollar sign $ and the Centering
icon.
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19. Now we will put in underlines to help the readers’ eyes move along. Highlight
cells C7-H7. This is the end of the list of expenses. The next row down is
totals. So to indicate that this is what we’re adding together, we’ll put an
underline here. After highlighting the cells, choose an underline style from the
Borders & Shading area of the Formatting Palette.

Similarly, highlight cells C12-H12 and choose the same underline.

For the Monthly Net Totals, I selected a double-underline. For this, you select
the cells C15-H15. Choose a double-underline from the Formating Palette.

20. Now is a good time to resize columns and rows. Click on the line between
column headings B and C. Hold down the mouse and drag over to the left a bit
to make column B smaller. There is nothing in that column - it’s just there to set
the right-aligned headings off from the actual figures.

Then highlight row headings 3 thru 15. Select Format ➪ Row ➪ Height…. Row
heights are listed in point sizes, so type in 18. This will make the rows
approximately space-and-a-half apart.

21. SAVE YOUR DOCUMENT!
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HOW TO PRINT:
Click in cell A1 and drag down to cell H15. This is what you want to print, so choose
File ➪ Print Area ➪ Set Print Area. This is the quick way to set what you want printed.
Unfortunately, you’ll probably notice a dashed line between your columns. This
indicates that your document will print out on more than one sheet.

To prevent this, choose File ➪ Page Setup… On the first tab (Page) choose Landscape
instead of Portrait. This will probably be enough for this table to print onto one page. If
you had a larger worksheet that you wanted on only one page, you would also want to
set the page to print 1 wide by 1 high in the Scaling area.

Click on the Margin tab next. Down at the bottom of this box there is a place where you
can set it so the table centers either horizontally, vertically, or both. I usually choose
these options.

Be sure to check how the page will look when you print by clicking on the Print Preview
button.

In Print Preview, if you notice that some of your figures are gone and replaced by pound
signs #####, don’t panic. Zoom in and the figures will be there. (If you’re looking at
your actual worksheet and see pound signs ####, then you need to expand your
column.)

Also in Print Preview, you’ll notice that your gridlines do not automatically appear, and
they won’t print either. This is different than in some older versions of Excel. If you want
the grid lines and/or row and column headers to appear, you need to turn on these
features in Page Setup on the Sheet Tab.
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FORMATTING DATES
In Excel, formatting dates can be one of the most frustrating things to do until you
understand how Excel handles dates. Then you’ll be able to make a date look any way
you want.

If you type: Excel displays:

2/24/01 2/24/01

2-24-01 2/24/01

February 24, 2001 24-Feb-01

24-Feb-2001 24-Feb-01

24 February 2001 24-Feb-01

Feb. 24, 2001 Feb. 24, 2001**

In all these cases except the last one, Excel recognizes that you’ve typed in a date and
will retain this information as a date. In the last example, Feb. 24, 2001, Excel does not
know this is a date and treats it as text only.

Excel handles dates as numbers. In the internal mechanism of Excel, every date is
changed from whatever you type in to a number. (The number is however many days it is
since January 1, 1904.) The number is then returned to the worksheet in whatever date
format has been designated. Because Excel works this way, you can use dates in
calculations. We can compare dates. We can figure out how many days until Christmas.
We can determine how old our friends are. Cool!

In order to have Excel return dates in the format we want, we need to tell it what we
want. Highlight the cell or cells you want to set date formats for. From the Format menu
choose Cells…. The first tab: Numbers should appear. If not, choose that tab. From the
list, choose Date. Then in the Type box, choose what style you want the date to be
formatted in.
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If your choice is not on the list you can create it yourself. Click on Custom from the
Category list. Scroll down to where the existing dates are (about half way).

The coding goes like this:

d day number without leading zero (1-31)

dd day number with leading zero (01-31)

ddd day of week abbreviation (Sun-Sat)

dddd day of week name (Sunday-Saturday)

m month number without leading zero (1-12)

mm month number with leading zero (01-12)

mmm month name abbreviation (Jan-Dec)

mmmm month name (January-December)

yy Last two digits of year (00-99)

yyyy Entire year number

h hours

m minutes

s seconds
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In the box, type in the codes for how you want your dates to look.

What you want: What to type in Type: box

February 24, 2001 mmmm dd, yyyy

Feb. 24, ’01 mmm. dd, ’yy

It doesn’t matter what format you put the date into the cell (so long as it is a date
format), it just matters how you’ve defined dates to look for output. In addition, if you
have set it up so that all that is returned is the month and year, but you enter in the day
also, Excel will remember the exact date. That information is not lost.

How Many Days Old Are You?

1. Open a new worksheet

2. In cell A1 type the words: Today’s Date

3. Tab to cell B1. Press Contol + ; (semicolon) which enters today’s date.

4. Move to cell A3 and type the words: My birthdate:

5. Tab to cell B3 and type in the day you were born (birth year, not current
year).

6. Move to cell A5 and type the words: How Old Am I?

7. Tab to cell B5 and put in this formula: =B1-B3  Hit the Enter key.

The result is probably in date format. To fix it, make sure cell B5 is selected.
Then go to Format Cells…. In the Number Tab, click on the General Category.
This switches your results from a date into a number. That’s how many days
old you are. WOW! I bet you can’t even count that high!
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Auto Formats
There is now a feature that can save you lots of time and effort. It’s called AutoFormat.
You can select your data on the worksheet, go to the Format menu and choose
AutoFormat. There will be several choices. Pick one and your data will be formatted
quickly and easily. You may need to make some adjustments.

Or:
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I made you do it the hard way so that you’d learn all that formatting stuff. The
AutoFormat tables really do look better than the one we did.


